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How to secure Microsoft Outlook using MFA

Modern authentication enables users to authenticate to Exchange using AD FS. When enabled, the
Outlook client redirects users to AD FS, which authenticates their identity and generates access tokens
that are subsequently validated by Exchange Server to grant users access to their mailboxes.

AD FS uses basic Active Directory authentication to verify users. This document details how to secure
this authentication process by incorporating an extra layer of MFA from ManageEngine ADSelfService
Plus.

Process flow

Instead of AD FS using Active Directory to authenticate the user, you can configure AD FS to utilize
ADSelfService Plus for user authentication. By doing so, you can leverage ADSelfService Plus' suite of
modern MFA factors to enhance the overall security of the authentication process. This is achieved by
configuring ADSelfService Plus as the identity provider (IdP) for AD FS.

This diagram illustrates the process:

6. ADSelfService Plus returns SAML assertion to AD FS. l
3. Exchange requests OAuth
ManageEngin® - verification from AD FS -
i < = ADFS <
ADSelfService Plus D ) - b
4. AD FS redirects the authentication [}
to ADSelfService Plus ./_\. Q
Exchange Server
5. ADSelfService Plus 7. AD FS issues access token to Outlook.
performs MFA Outlook accesses Exchange using the
access token, Note - Basic authentication
(password) will be prompted if
Modern Authentication is not
enabled at Exchange

1. Login attempt to mailbox from Outlook

v W

2. Outlook connects to Exchange

;A <«
<
8. Exchange allows Outlook access to mailbox

User Outlook App

1. A user provides their email address to their Outlook client.

2. Outlook connects to Exchange Server.

3. Exchange Server requests modern (OAuth) authentication from AD FS.

4. AD FS now redirects the authentication request to ADSelfService Plus via SAML.

5. ADSelfService Plus performs the actual authentication by presenting the user with MFA.

6. Upon successful MFA, ADSelfService Plus returns a SAML assertion response to AD FS. After validating
the SAML response from ADSelfService Plus, AD FS issues an access token to Outlook.

7. Outlook tries accessing Exchange Server with the access token from AD FS.

8. If the access token is valid, Exchange Server now allows Outlook access to the user's mailbox.
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Prerequisites

e Exchange Server 2019 CU13 or later (Exchange Server 2016 supported with 2019 CU13 as the
front-end server)

* AD FS for Windows Server 2019 or later

¢ Outlook 2021 (version 2304 or later) from the Microsoft 365 suite on machines running Windows 11

22H2 or later (ensure that update KB5023706 for version 22H2 is installed).

Note:
¢ The latest version of Outlook for Windows (version 1.2024.605.100) in the Microsoft Store

does not support on-premises Exchange Server. Microsoft might add on-premises Exchange
Server support for these versions later.
* Modern authentication to an on-premises Exchange server for clients such as Outlook for Mac,

Outlook for iOS and Android, and the Apple Mail app for iOS, is yet to be added by Microsoft.

Detailed prerequisites for setting up modern authentication for Exchange Server, AD FS, the Outlook

client, and Windows can be viewed here.

Configuration Steps

You will need to configure the following for modern authentication:
e ADFS

* On-premises Exchange Server
e The Outlook client on the user's Windows machine

Once these have been configured, you will need to configure

e MFA for Outlook using ADSelfService Plus
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AD FS configuration for modern authentication

1. Ensure that AD FS is functioning properly by accessing your metadata URL from a browser bar.

dfs.mydomain.com/Fed a 07-06/FederationMetad

You've gone Incognito

Others who use this device won't see your activity, so you can browse more privately. This won't
change how data is collected by websites you visit and the services they use, including Google.
Downloads, bookmarks and reading list items will be saved. Lt more

Chrome won't save: Your activity might still be visible to:
* Your browsing history » Websites you visit

* Cookies and site data * Your employer or school

¢ [nformation entered in forms * Your internet service provider

Block third-party cookies
When on, sites can't use cookies that track you across the web. Features on some
sites may break.

You can find the steps to access your metadata URL here. It should be in this format:
https://<ADFS_Server FQDN>/federationmetadata/2007-06/federationmetadata.xml. If AD FS is

functioning properly, your federation metadata will be downloaded as an XML file.

2. Open Server Manager on your Windows server and navigate to Tools > AD FS Management.

In the AD FS console that opens, click on Edit Federation Service Properties to open the Federation
Service Properties pop-up.

@ ADFS
g Fle Action View Window Help

«=|m Bm

] Service

. ADFS B
Overview

Add Relying Party Trust.

Active Directory Federation Senvices provides single-sign-on (SSO) access for client computers,
Leam More About AD FS
What's newin AD FS?
AD FS Deployment Guide
ADFS Operations Guide
Integrate Azure Muli Factor Authentication with AD FS Revoke All P
Monitor AD FS Service using Azure Active Directory Connect Health

Edit Published Claims

Leam More About Azure Active Directory

Azure Active Directory. a seperate online service, can provide simplified idenity and access management, security reporiing and single sign-on to cloud and on-premises web apps.
What s Azure Active Directory?
Extend your directory to Azure Active Directory

Identity and Access Management

3. Choose an appropriate web SSO lifetime to determine the number of minutes after which the user

has to re-authenticate. Click Apply and then OK to close the pop-up.
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Federation Service Properties

General Organization Events
Federation Service display name:
|ssP ADFS |

Example: Fabrikam Federation Service

Federation Service name:

|adfs.ad55p.com |

Example: fs fabrikam.com

Federation Service identffier:

|hﬂp:,-’,-’adfs.adssp.com,-’adfs,-’senricesﬂn.lst |

Example: hitp://fs fabrikam .com/adfs/services/trust
| Web 550 lfetime (minutes): |10 = |

[] Enable delegation for service administration

[] Allow Local System account for service administration

Delegate name:

Allow Local Administrators group for service administration

Cancel Apply
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4. Inthe LHS pane, navigate to ADFS > Service > Device Registration. Verify that device registration is
configured and device authentication is enabled. This step is recommended to reduce the number

of authentication prompts for users and can help enforce Access Control Policies in AD FS.

G ADFS

% File Acion View Window Help

«=| 2@ B

[ ADFs Device Registration
v [ Service

[ Attribute Stores

Device Registration Overview
[ Authentication Methods

Allow users to register devices with Active Dirsctory

Status.

Disable device authertication

Supported Account Formats

onfig To alow addtional

“Configuing Device Regitration”
someonet @adssp.com

Leam More
Planing for Device Registation
Corfiguing Device Registation
ADFS Hep

5. Configure an application group for modern authentication in Outlook on Windows:

a. Right-click on Application Groups and click Add Application Group.

@1 ADFS

W File  Action View Window Help
=3 2= B
7 ADFS
v [ Service
(] Attribute Stores
[ Authentication Methods
(] Certificates
[ Claim Descriptions

Application Groups

Hame
Outlook

Description

1] Device Registration
1] Endpoints
[ Scope Descriptions
1] Web Application Proxy
(] Access Control Policies
[ Relying Party Trusts
71 Claims Provider Trusts
(] Application Grpun

Add Application Group...

View >

New Window from Here
Refresh

Help

- a x
e
>
New Window from Here
|0 Refresh
B Hep
- X
-8 %
Actions
Application Groups -
Add Application Group..
View »
Mew Window from Here
|l Refresh
H Hep
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b. The Add Application Group wizard will open. Under Template, select Native Application

accessing a web APl and type an appropriate name for the application, such as Outlook. Click Next.

§i Add Application Group Wizard X
Welcome
Stops Name:
Ve [Outiook |
@ Native J
Description:
@ Configure Web API
@ Apply Access Control Policy
@ Configure Application
Pemias
emissions Template:
® Sumnary Client-Server application
@ Complete

[ Jsive copicaion acoessinga web 71

Irg Server application accessing a web AP|

q Web browser accessing a web application
Standalene applications

ﬁfl Native application

T sever appication

@ web sl

More information...

c. In the Native application section, add the following client identifier and Redirect URI and click Next:
* Client Identifier: d3590ed6-52b3-4102-aeff-aad2292ab01c
¢ Redirect URI (add both of these URIs):

urn:ietf:wg:oauth:2.0:00b

ms-appx-web://Microsoft. AAD.BrokerPlugin/d3590ed6-52b3-4102-aeff-aad2292ab01c

@ Add Application Group Wizard X
Native application

S Name:

@ Welcome |Out|ook - Mative application ‘

@ Mative application

Clignt Identifier:

@ Configure Web AP|
[43580ed6-52b3-4102-acff aad2282ab01c |

@ Apply Access Control Policy

@ Configure Application Pl
Pemissions |Er.amp\e: hitps://Contoso com ‘ Add
@ Summary um:ietf:wg oauth:2. 0:oob T
@ Complete ms-appr-web //Microsoft. AAD. BrokerPlugin/d 3590ed6-52b 3-4102-2eff-2ad2232zb 01
Description
< Previous Next > Cancel

d. In the Configure Web API section, add all the FQDNs used by your Exchange environment,
including auto-discover, load balancing, and server FQDNs. For example:
https://autodiscover.mydomain.com/

https://mail.mydomain.com
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Configure Web API

Steps

@ Welcome

@ Native application

@ Configure Web API

@ Apply Access Control Policy

@ Configure Application
Permissions

@ Summary
@ Complete

Note:

i Add Application Group Wizard

Mame

|Outlook - Web API

Identfier:

Add

https://autodiscover mydomain .com/
https://mail mydomain com/

Remove

Description:

<Provous Cance
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Include all the client-facing URLs for the setup to work properly. Ensure that the URLs

start with https:// and contain a trailing forward slash (/).

e. Inthe Apply Access Control Policy section, select Permit everyone. You can change this later

if needed. Leave the checkbox at the bottom of the page unchecked. Click Next.

‘@ Add Application Group Wizard

Choose Access Control Policy

Steps

@ Welcome

@ Native application

@ Corfigure Web API

@ Apply Access Control Policy

@ Corfigure Application
Permissions

@ Summary

@ Complete

Choose an access control policy:

Description

Permit everyons and require MFA for specfic group
Pemit everyone and require MFA from extranet acoess

Pemit everyone and require MFA, allow automatic devi
Permit everyone for infranet access
Pemmit specific group

Pemit everyone and require MFA from unauthenticated .

Grant access to everyone and require MFAF
Grant access to the infranet users and requir...
Grant access to everyone and require MFAT...
Grant access to everyone and require MFAF
Grartt access to the intranet users

Grant access to users of one or mare specfi..

Policy

Pemit everyons

O | do not want to configure the access control policy at this time. No users will be permitted access for this

application

< Previous

Cancel

f. In the Configure Application Permissions section, choose Native application. Under Permitted

scopes, select user_impersonation in addition to openid, which is selected by default.
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@ Add Application Group Wizard X
Configure Application Per

Steps Corfigure permissions to enable client applications to access this Web AP,

@ Welcome Client application (caller):

@ Native application

Name Description

© Corfigure Web API Oxtioskk - Native applicat

@ Apply Access Control Policy
® Configure Application
Sids

@ Summary
@ Complete

Descrption

Request the email claim for the signed in user.

Request profile related claims for the signed in user.

Request use of the Open|D Connect authorization protocol

The vpn_cert scope allows an application to request VPN ...

.| Request pemission for the application to access the resour.
The logon_cet scope allows an application to request logo..
Scope allows broker client to request primary refresh token.

g. Click Next and complete the setup to create the application group.

6. Add Issuance Transform Rules to the newly created application group:

a. Right-click on the Outlook application group and select Properties.

G 2D FS - X
@@ File  Action  View Window Help 8=
=% |n= H
« ] Senvice T R RR———IIIIII———————— .
= - Application Grou -
= Attribute Stores Name Description PPl ps
1 Authentication Methods ouiode ey Add Application Group...
[ Certificates (epEifs View »
- Clim Description: Delete New Window from Here
(] Device Registration
(] Endpoints Help |G Refresh
] Scope Descriptions B Hep
[ Web Application Proxy
[ Access Control Policies Outlook -
[ Relying Party Trusts Properties
[ Claims Pravider Trusts
| Application Groups K Delete
H Help

b. Click Edit under Web API settings.

Outlook Properties x

General

Name:

Ovtlook

Description:

Applications:

Name Description

Mative application
Outlook - Native application
Web API

Add application. Edit... Remove

OK Cancel Apply
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c. Under Issuance Transform Rules, click Add Rule.

Outlook - Web AP Properties *

Idertfiers Motss  Access control policyl  Issuance Transform Rules  |Client Pemmissions

The following transform rules specify the claims that will be sent to the relying party.

Order  Rule Name lssued Claims

Add Rule Edit Rule Remove Rule

QK Cancel Apply

d. Inthe Choose Rule Type section, select Send Claims Using a Custom Rule from the

Claim rule template drop-down.

“ﬁ Add Transferm Claim Rule Wizard X
Select Rule Template

Steps Select the template for the claim rule that you want to create from the following list. The description provides

@ Choose Rule Type details about each claim rule template.

@ Configure Claim Rule Claim rule template

Send Claims Using a Custom Rule ~

Send LDAP Attibutes as Claims
Send Group Membership as a Claim
Transform an Incoming Claim

rules are

=
Send Claims Using a Custom Rule

* Sending claims from a SQL attribute store

* Sending claims from an LDAP attribute store using a custom LDAP filtter

* Sending claims from a custom attribute store

* Sending claims only when 2 or more incoming claims are present

* Sending claims only when an incoming claim value matches a complex pattem
* Sending claims with complex changes to an incoming claim value

* Creating claims for use only in later ules

< Previous Next = Cancel

e. Click Next to proceed to the Configure Claim Rule section using the information in the table below.
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Claim Rule Name Custom Rule

ActiveDirectoryUserSID

c:[Type == "http://schemas.microsoft.com/ws/2008/06/
identity/claims/primarysid"] => issue(claim = ¢);

ActiveDirectoryUPN

c:[Type == "http://schemas.xmlsoap.org/ws/2005/05/
identity/claims/upn"] => issue(claim = ¢);

ApplIDACR

=> issue(Type = "appidacr", Value ="2");

SCP

=> issue(Type = "http://schemas.microsoft.com/identity/
claims/scope", Value ="user_impersonation");

You will need to configure each claim rule individually, as shown in the screenshot below.

Click Finish to add each claim rule.

‘.ﬁ Add Transferm Claim Rule Wizard *

Configure Rule

Steps
@ Choose Rule Type
@ Corfigure Claim Rule

“fou can configure a custom claim rule, such as a rule that requires multiple incoming claims or that extracts
claims from a SQL attribute store. To configure a custom rule, type one or more optional conditions and an
issuance statement using the AD FS claim rule language.

Claim rule name:

‘.ﬂctive DirectorylserSID I

Rule template: Send Claims Using a Custom Rule

Custom rule:

ci[Type ==
"http://schemas.microsoft.com/ws/20053/06/identity/claims/primarysid”]
=> isgsue{claim = c) :|

< Previous Cancel

After adding the rules, the Issuance Transform Rules tab should look similar to the

following screenshot:
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Outlook - Web AP| Properties X
|dentifiers  Motes  Access control policy  lssuance Transform Rules  Client Permissions

The following transform rules specify the claims that will be sent to the relying party.

Order  Rule Name Issued Claims
1 ActiveDirectory UserSID =See claim rule>
2 ActiveDirectory UPN =See claim rule>
3 ApplDACR =See claim rule>
4 SCP <See claim rule>
Add Rule... Edit Rule... Remove Rule...
0K Cancel Apphy

f. Click Apply and then OK to save your configuration. AD FS has now been configured for

modern authentication.
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Configuring the on-premises Exchange Server

By default, the on-premises Exchange server utilizes basic authentication. To enable MFA instead of
basic authentication, we must configure the on-premises Exchange server to employ modern

authentication (OAuth) via AD FS, for users accessing Exchange through Outlook.

This involves four steps:
Verifying that the virtual directori n r Exchan rver ar

2. Redistering your AD FS server as the authentication server.
3. Setting the AD FS server as the default authorization endpoint.
4. Enabling modern authentication at the organizational level.

You will need to use the Exchange Management Shell on your Exchange server to configure these

settings. You can find information on using the Exchange Management Shell here.

1. Verify that the virtual directories in your Exchange server are configured to use OAuth.

On your Exchange server, open the Exchange Management Shell and run the following commands:

Get-MapiVirtualDirectory -Server <ExchangeServerName> | Format-List *auth*
Get-WebServicesVirtualDirectory -Server <ExchangeServerName> | Format-List *auth*
Get-OabVirtualDirectory -Server <ExchangeServerName> | Format-List *auth*
Get-AutodiscoverVirtualDirectory -Server <ExchangeServerName> | Format-List *auth*

Note: Replace <ExchangeServerName> with your the name of your Exchange server.

Each command retrieves the authentication settings for the specified virtual directory type on the given

Exchange server. Verify that OAuth is an authentication method for each virtual directory type.
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Format-

Format-List *auth®

OAuth}
OAuth}

*auth*

Ntlm,
Ntlm,

2. Register your AD FS server as the authentication server

Exchange accepts OAuth tokens only from authentication servers (AD FS servers). Register your AD FS

server as the authentication server for Exchange using the following command:

New-AuthServer -Type ADFS -Name <MyADFSServer> -AuthMetadataUrl https://<adfs server
FQDN>/FederationMetadata/2007-06/FederationMetadata.xml

Note: Replace <MyADFSServer> and <ADFS server FQDN> with the name of your AD FS server

(this will serve as an identifier for Exchange Server) and the FDQN of your AD FS server, respectively.

B8 Machin: CE———

w-AuthServer


https://www.manageengine.com/products/self-service-password/

ManageEngin@

ADSelfService Plus

3. Set your AD FS server as the default authorization endpoint

When an Outlook client requests modern authentication from Exchange, Exchange responds with the
authorization URL of the DefaultAuthorizationEndpoint. Set the AD FS server you created as the
DefaultAuthorizationEndpoint:

Set-AuthServer -ldentity <MyADFSServer> -IsDefaultAuthorizationEndpoint $true

B Machine:

4. Enable modern authentication at the organizational level

Finally, enable modern authentication for your organization with the following command:

Set-OrganizationConfig -OAuth2ClientProfileEnabled $true

et-AuthServer MyADFSServer
et-OrganizationConfig

After completing the steps above, users logging into the on-premises Exchange server from their

Outlook mail client on Windows will be prompted with modern authentication via AD FS.

Configuring the Outlook client on users' Windows machines

By default, Outlook for Windows and the Outlook app in the Microsoft 365 suite use the Windows
Credential Prompt for authentication. Since modern authentication via AD FS is disabled for Outlook by
default, we need to enable modern authentication and delegate authentication to AD FS. To do this, we

will:

e Enable modern authentication via AD ES for Outlook

e Add AD FS as a trusted domain
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Enabling modern authentication on Outlook

By enabling modern authentication on Outlook, we will enable authentication via a browser instead of

the default Windows Credential Prompt. This step involves modifying the registry on client machines.

1. To enable modern authentication via AD FS for Outlook on Windows, add the following REG_DWORD
hex value to HKCU\SOFTWARE\Microsoft\Office\16.0\Common\Identity\

EnableExchangeOnPremModernAuth 1

% Registry Editor -_ (m] X
file Edit View Favorites Help

~omputer\HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Common\Identity

Charting Name Tvpe Data

ClientTelemetry
CloudPolicy

ContactCard
CustomUIValidationCache
DocumentActivityCapabilities

v .v.v i

Draw
DrawAlerts
DRM
Experiment i
ExperimentConfigs #éjEnableExchangeOnPremModernAuth | REG_DWORD 0x00000001 (1)
ExperimentEcs
FavoritePens
FilelO
FixedFormat
> Fluid

Fonts
> General

N

Graphics
HelpViewer
v Identity
> DecToldMapping
> |dentities
OneAuthCenfigCache
> Profiles
> ServiceAuthlnfoCache
S SPOCankieCache

Adding the AD FS domain as a trusted domain

By adding AD FS as a trusted domain, we enable Outlook to delegate modern authentication to AD FS.

This is disabled by default; please follow the steps below to enable it:

1. Open the Windows Registry Editor on the end-user machine. Navigate to HKEY_LOCAL_MACHINE\
SOFTWARE\Policies\Microsoft\. Create a folder called AAD and under it, a subfolder called

AuthTrustedDomains.

2. Right-click AuthTrustedDomains and click on New > Key. A subfolder named New Key #1

will be created.


https://www.manageengine.com/products/self-service-password/

B Registry Editor
File Edit View Favorites Help

ComputertHKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\ AADVAUth TrustedDomains\New Key #1

ManageEngin@

ADSelfService Plus

»

S

Y

Microsoft
Meozilla
meozilla.org
MozillaPlugins
Node,js
Notepad-+-+
0BS Studio
0DBC
OEM
OpenSsH
Oracle
Partner
PC-Doctor

Policies

BraveSoftware

Dell

Google

Microsoft

~ 70 AAD

i+ 77 AuthTiustedDomains

H : https://adfs.adssp.com/

New Key .-

). Blemetrics
)‘ cloud
5 © Cryptography
L7 FiDO
FVE

] Internet Explorer

: Microsofthccount
b MicrosoftEdge

5 77 MSDeploy

5 © office

MName

2b] (Default)

Type
REG_SZ

Data

(value not set)

3. Rename New Key #1as your AD FS domain URL. Create another key and rename it to your AD FS

domain URL, and append a forward-slash (/) to it.

i.e., these changes must be in the following format:

i. HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\AAD\AuthTrustedDomains\
<ADFS domain URL>
ii. HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\AAD\AuthTrustedDomains\
<ADFS domain URL>/

Replace <ADFS domain URL> with your AD FS domain URL.

B Registry Editor
File Edit View Favorites Help

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\SyncintegrationClients

>

>
>
>
>

K v v v v v vy

Microsoft
Mozilla
mozilla.org
MozillaPlugins
Node.js
Notepad++
0BS Studio
ODBC
QOEM
OpenSsH
QOracle
Partner
PC-Doctor
Policies
BraveSoftware
Dell
Google
Microsoft

~ AAD

AuthTrustedDomains
https://adfs.mydomain.com

https://adfs.mydomain.com/

> Biometrics
> cloud
» Cryptography
22 FDO
FVE

> Internet Explorer
MicrosoftAccount
, MicrosoftEdge

5 77 MSDeploy

» office
: PeerDist
Peernet

Mame

ab)(Default)

Type
REG_SZ

Data

(value not set)
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Note: For ease of deployment, these registry changes can be configured on end-user machines

using a Group Policy.

Configuring MFA for Outlook using ADSelfService Plus

Now, you should configure AD FS to delegate user authentication to ADSelfService Plus, thus

integrating an additional layer of MFA.

o Set up ADSelfService Plus to authenticate Outlook users
o Configure the AD FS server to delegate authentication to ADSelfService Plus

Prerequisite

Download and save the AD FS server federation metadata by using the following URL in a browser:

https://<adfs_fgdn>/FederationMetadata/2007-06/FederationMetadata.xml

Note: Replace <ADFS server FQDN> with the FDQN of your AD FS server.

adfs.mydomain.com/F onMetada 07-06/FederationMetadata.x

You've gone Incognito

Others who use this device won't see your activity, so you can browse more privately. This won't
change how data is collected by websites you visit and the services they use, including Google.
Downloads, bookmarks and reading list items will be saved.

Chrome won't save: Your activity might still be visible to:
* Your browsing history * Websites you visit

+ Cookies and site data * Your employer or school

* Information entered in forms * Your internet service provider

Block third-party cookies
When on, sites can't use cookies that track you across the web. Features on some
sites may break.
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Set up ADSelfService Plus to authenticate Outlook users

1. Log in to ADSelfService Plus as an administrator.

2. Now, navigate to Configuration > Self-Service > Password Sync/Single Sign On > Add Application >
Custom Application.

3. Enter the Application Name, Description, and Domain Name in the respective fields.

4. Choose the policy containing the users you wish to provide SSO access to AD FS from the
Assign Policies drop-down.

5. Select the checkbox Enable SSO using SAML.

6. Set Support SSO flow to SP initiated.

7. In the Upload Metadata field, upload the file downloaded previously in the prerequisite step.

8. Under Provider Settings, enter the following information:
a. Select RSA-SHA256 from the RSA SHA Algorithm drop-down.
b. Set the SAML Response value to Signed.
c. Select the option Exclusive Canonicalization from the Canonicalization Method drop-down.

d. Click Advanced in the top-left corner.

£ Create Custom Application < Back

All Applications (125
Application Name  ADFS B 1dp Details § & Advanced

All
~ Domain Name | demo.com

Productivity 48
Assign Policies Al Policies Selected

IT Management

Customer Support s Smallicon

cRM

Analytical Tools s Large Icon

SAML OAuth/OpenID Connect

Enable SSO Using SAML

Support S5O Flow SP Initiated

Upead etadata Fedaraionteadata

SAML Redirect URL https://selfservice.com/adfs/Is/

ACS URL htps://self:

Provider Settings +

RSA SHA Algorithm RSA-SHA256
SAML Response SIGNED

Canonicalization Method Exclusive Canonical lization

9. Under the SAML Assertion Attributes Configuration section, create an attribute and enter the

following values:

a. Enter an attribute name as “http://schemas.xmlsoap.org/ws/2005/05/identity/claims/upn”
and choose userPrincipalName for the Value drop-down.
b. Add another attribute name as “http://schemas.microsoft.com/ws/2008/06/identity/claims/

primarysid” and choose objectSid from the Value drop-down.
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* Navigate to Configuration > Self-Service > Directory Self-Service.
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Click on Manage Custom Attributes at the top-right corner and create a custom attribute

called objectSid.

e Linkitto the objectSid AD attribute by entering objectSidin the LDAP field.

Choose Unicode String as the datatype. Click Add.

Update Custom Attribute

Display Name objectSid
LDAP Name objectSid

Data Type Unicode String v

Cancel

< Back X

c. Add yet another attribute name as “http://schemas.microsoft.com/ws/2008/06/identity/claims/

windowsaccountname” and choose sAMAccountName from the Value drop-down.

Advanced Configuration -

Account Linking

SAML Assertion Attributes Configuration

Assertion Attribute Attributes Value
http://schemas.xmlscap.org/ws/ userPrincipalName
http://schemas.microsoft.com/w objectsid
http://schemas.microsoft.com/w sAMAccountName

Note When a SAML assertion is sent to the service provider, the identity provider asserts that

the user is authenticated.

Use the above setting to add certain attributes, that are required by the service
provider, to the SAML assertion, that will override the default attributes (first name, last
name, email address).

Cancel
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Click Save to go back to the Create Custom Application page.

10. Click IdP details at the top-right corner and select Download IdP Metadata, which will download

the metadata file required for later.

IdP Details

S50 (sAML)

Please configure the application with IdP details given below to complete the setup. Help

Entity ID https://adselfserviceplus.com/iamapps/ssologin/custom_saml_za

Login URL https://adselfserviceplus.com/iamapps/ssologin/custom_saml_za

Logout URL https://adselfserviceplus.com/iamapps/ssologout/custom_saml_

SHAL FingerPrint b9:42:5f:5d:df:8b:05:31:a3:7a:90:9d:dd:65:f0:¢6:92:23:27:c

@ Download X.509 Certificate fn Download IdP Metadata

Close

Configure the AD FS server to delegate authentication to
ADSelfService Plus

Configuring the AD FS server to delegate authentication to ADSelfService Plus involves the

following steps:

Adding a new claims provider trust
Adding claim rules
Executing Windows PowerShell commands

Enabling MFA for cloud apps in ADSelfService Plus

Step 1: Adding a new claims provider trust

1. Open Server Manager on your Windows server and navigate to Tools > AD FS Management.

Inthe AD FS console that opens, navigate to AD FS > Claims Provider Trusts.

G ADFS _ %
W File Action View Window Help I
L -] il 7]
* 5 e ont Pt OuslyNare sl s ks Tusts 3
ADSSF IdP Yes pr N
# APPHESTEN TERRE New Window from Here

(G Refresh

B Hep

Active Directory -

Update from Federation Metadata...
Edit Claim Rules...

Disable

Properties

E Hep
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2. Click Add Claims Provider Trust in the Actions pane. This will open the Add Claims Provider
Trust Wizard. Click Start.

R ADFS

G File Action View Window Help

CEYET:R 1=

T ADFS
1] Senice
1] Access Control Policies
7 Relying Party Trusts
3 Claims Provider Trusts
) Application Groups

Claims Provider Trusts

Display Name
Active Directory
ADSSP idP

Welcome

Steps

@ Welcome

@ Select Data Source
@ Readyto Add Trust
@ Finish

@ Add Claims Provider Trus!

Enabled
Yes
Yes

Welcome to the Add Claims Provider Trust Wizard

“This wizard wil help you add  new claims provider trust to the AD FS corfiguration database. Claims
providers issue clams about a userin a securty token for a paricular transaction.

The claims provider trust that this wizard creates defines how this Federation Service recognizes the claims
provider and consumes the claims that i issues. You can define acceptance transform rules for issing claims
to the relying party after you complete the wizard

< Previous Cancel

Actions
Claims Provider Trusts -

Add Claims Provider Trust...
View »
New Window from Here

[ Refresh

H Help

Active Directory -
Update from Federation Metadata...
Edit Claim Rules..
Disable
Properties

Help

3. Inthe Select Data Source section, choose Import data about the claims provider from a file and

upload the metadata file downloaded in Step 11 of the ADSelfService Plus configuration steps.

Click Next.

@ anrs

@ File Action View Window Help
L ANl 7

J ADFS
> [ Serviee
| Access Control Policies
| Relying Party Trusts
7 Claims Provider Trusts
~ Application Groups

Display Name
Active Directory
ADSSP IdP

Enabled

Select Data Source

Steps

@ Welcome

@ Select Data Source
@ Readyto Add Trust
@ Finish

@0l Add Claims Provider Trust Wizard

Select an option that this wizard will use to obtain data about this claims provider:

© Impott data abovt the claims provider published online or on a local network

Use this option to import the: necsssary data and certficates from a claims provider organization that
pubiishes fs federation metadata onine or on a local networ

Federation metadata address thost name or URL:

Example: fs fabrikam com or hitps:/ s fabrikam com/

| @ Import data about the claims provider from a file

Use this option to import the: necsssary data and certficates from a claims provider organization that has
provided ts federation metadata in a file

| = \metadataxml | | Browse
O Enter claims provider trust data manually
Use this option to manually input the necessary data about this claims provider organization
< Previous Next > Cancel

- x
- 8%
Actions
Claims Provider Trusts -
Add Claims Provider Trust...
View >
New Window fram Here
|6 Refresh
H Hep
Active Directory a

Update from Federation Metzdata...
Edit Claim Rules...

Disable

Properties

H Hep
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4. In the Specify Display Name section, enter the desired Display name. Click Next.

&g 4D FS

W File Action View Window Help
ey m BiE

1ADFS

5 [ Service

| Access Control Policies
| Relying Party Trusts

5 Claims Provider Trusts
| Application Groups

o

a Provider Trusts Actions

Specify Display Name

Steps.

@ Welcome

@ Select Data Source
@ Speciy Display Name
® Readyto Add Trust
® Fiish

Display Name Enabled
Active Directory Yes
ADSSP IdP Yes
@ Add Claims Provider Trust Wizard X

Type the display name and any optional notes for this clams provider.
Display name:

|~D55P Idertity Provided |

—

Notes:

< Previous | Next > | Cancel

p ADFs

Wp File Action View Window Help
«=|nm @B

[ ADFs

> [ Service

] Access Control Policies
[ Relying Party Trusts
{3 Claims Provider Trusts
(] Application Groups

Claims Provider Trusts

Display Name

ADSSP IdP

Active Directory

Enabled
Yes
Yes

Claims Provider Trusts
Add Claims Provider Trust.
View
New Window from Here
(@ Refresh
H Hep
Active Directory
Update from Federation Metadata
Edit Claim Rules...
Disable
Properties

H Hep

Actions

@ Add Claims Provider Trust Wizard

Ready to Add Trust

Steps

Welcome

Select Data Source
Specfy Display Name
Ready to Add Trust
Finish

The ciaims provider trust has been configured. Review the following seftings. and then click Next to add the
claims provider trust ta the AD FS corfiguration database:

Mnitonng  |dentfiers Cetficates Encyption Offered Claims  Organization Endpoints  Mote| * | »
Specify the trust monitoring settings for this claims provider trust
Claims provider's federation metadata URL:

“This claims provider's federation metadata was last checked on

<never >

This claims provider trust was last updated from federation metadata on

<never >

< Previous Cancel

Claims Provider Trusts
Add Claims Provider Trust
View
New Window from Here
[d] Refresh
Help
Active Directory
Update from Federation Metadata..
Edit Claim Rules...
Disable
Properties
Help

5. Complete the remaining steps in the wizard by retaining the default values for the rest of the fields.
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Step 2: Adding claims rules

1. Once the claims provider trust configuration is complete, the Edit Claims Rule for ADSSP Identity

Provider editor window opens. Click Add Rule.

Edit Claim Rules for ADSSP |dentity Provider
Acceptance Transform Rules

The following acceptance transform rules specify the incoming claims that will be accepted
from the claims provider and the outgoing claims that will be sent to the relying party trust.

Order  Rule Name lssued Claims

Add Rule... Edit Rule... Remeove Rule...

Cancel Foply

2. From the Claim rule template drop-down, select Pass Through or Filter an Incoming

Claim and click Next.

‘1@ Add Transfoerm Claim Rule Wizard X
Select Rule Template
Steps Select the template for the claim rule that you want to create from the following list. The description provides

@ Choose Rule Type details about each claim rule template:

@ Configure Claim Rule Claim rule template
Pass Through or Fitter an Incoming Claim

Send LDAP Attributes as Claims
Send Group Membership as a Claim

tum\ng claims
Jaim type

will send all incoming group claims. You

or example, you can use this ule template fo create a e
can also use this rule to send only UPN claims that end with “@fabrikam™. Multiple claims with the same
claim type may be emitted from this rule. Sources of incoming claims vary based on the rules being edited.

Previeus Mext = Cancel
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3. In the next window, enter a Claim rule name and set UPN as the Incoming claim type. Choose the

Pass through all claim values radio button. Click Finish to complete adding the claims rule.

@ Add Transform Claim Rule Wizard X
Configure Rule

Steps You can configure this rule to pass through or fiter an incoming claim. You can also configure this rule to fiter
claims that are generated by previous rules. Specify the claim type and whether only some claim values or all

@ Choose Rule Type claim values should pass through

@ Configure Claim Rule
Claim rule name:

fuen | |

Rule template: Pass Through or Fiter an Incoming Claim
| Incoming claim type: |L|PN\ I ~ |
[iparadiial

I@ Pass through all claim values I

() Pass through anly a specfic claim value

(”) Pass through only claim values that match a specfic email suffix value:

(7) Pass through only claim values that start with a specific value

< Previous Cancel

Acceptance Transform Rules

The following acceptance transform rules specify the incoming claims that will be accepted
fram the claims provider and the outgeing claims that will be sent to the relying party trust.

Order  Rule Name Issued Claims
1 UPN UPN
Add Rule... Edit Rule... Remove Rule...
(0] 4 Cancel Apply

4. You need to add two more claim rules. So, click Add Rule from the Edit Claims Rule for ADSSP

Identity Provider editor again.
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Select Rule Template

Steps
@ Choose Rule Type
@ Configure Claim Rule
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Select the template for the claim rule that you want to create from the following list. The description provides
details about each claim rule template.

Claim nule template

Pass Through or Filter an Incoming Claim

Claim rule template description:

Using the Pass Through or Fiter an Incoming Claim rule template you can pass through all incoming claims
with a selected claim type. You can also fiter the values of incoming claims with a selected claim type.
For example, you can use this rule template to create a rule that will send all incoming group claims. You
can also use this rule to send anly UPN claims that end with “@fabrikam”. Multiple claims with the same
claim type may be emitted from this rule. Sources of incoming claims vary based on the rules being edited.

Mext > Cancel

5. From the Claim rule template drop-down, select Pass Through or Filter an Incoming

Claim and click Next.

‘ﬁ’ Add Transform Claim Rule Wizard

Configure Rule

Steps
@ Choose Rule Type
@ Configure Claim Rule

You can configure this rule to pass through o fitter an incoming claim. You can also corfigure this rule to fitter
claims that are generated by previous rules. Specify the claim type and whether only some claim values or all
claim values should pass through.

Claim rule name:

‘Wlndnws account name|

Rule template: Pass Through or Filter an Incoming Claim

Incoming claim type: ‘Windows account name

[® Pass through all claim values

(O Pass through only a specific claim value

(O Pass through only claim values that match a specific email suffix valus:

() Pass through only claim values that start with a specffic value:

< Previous Cancel

6. In the next window, enter a Claim rule name and set Windows account name as the Incoming

claim type. Choose the Pass through all claim values radio button. Click Finish to complete

adding the claims rule.
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es for ADSSP |dentity Provider w

Acceptance Transform Rules

The following acceptance transfomm rules specify the incoming claims that will be accepted
from the claims provider and the outgoing claims that will be sent ta the relying party trust.

Order

1
2

Rule Name lssued Claims

UPN UPN

Windows account name Windows account name

Edit Rule... Remove Rule...

oK Cancel Apply

7. You need to add one more claim rule, so click Add Rule again.

%

Select Rule Template

Steps
@ Choose Rule Type

Select the template for the claim rule that you want to create from the following list. The description provides
details about each claim rule template.

@ Corfigure Claim Rule Claim rule template:

Pass Through or Fitter an Incoming Claim

Claim rule template description:

Lsing the Pass Through or Fitter an Incoming Claim rule template you can pass through all incoming claims
with a selected claim type. You can also fiter the values of incoming claims with a selected claim type.
For example., you can use this rule template to create a rule that will send all incoming group claims. You
can also use this rule to send only UPN claims that end with “@fabrikam™. Multiple claims with the same
claim type may be emitted from this rule. Sources of incoming claims vary based on the rules being edited.

Cancel
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8. From the Claim rule template drop-down, select Pass Through or Filter an Incoming

Claim and click Next.

25
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@ Add Transform Claim Rule Wizard

Configure Rule

Steps
@ Choose Rule Type
@ Corfigure Claim Rule
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You can configure this rule to pass through or fitter an incoming claim. You can also configure this rule to fiter
claims that are generated by previous rules. Specify the claim type and whether only some claim values or all
claim values should pass through

Claim rule name

‘ Primary 510

Rule template: Pass Through or Fiter an Incoming Claim

1
Incoming claim type: |Frim.ar)I SID |

|@ Pass through all claim value: |

() Pass through only a specific claim valus

() Pass through only claim values that match a specific email suffix value:

(*) Pass through only claim values that start with a specific value:

< Previous Cancel

9. In the next window, enter a Claim rule name and set Primary SID as the Incoming claim type.

Choose the Pass through all claim values radio button. Click Finish to complete adding

the claims rule.

Once all three claim rules are added, the Edit Claim Rules for ADSSP Identity Provider dialog box

should look like this:

Acceptance Transform Rules

The following acceptance transform rules specify the incoming claims that will be accepted
from the claims provider and the outgoing claims that will be sent to the relying party trust.

Order  Rule Name lssued Claims
1 UPN UPN
2 Windows account name Windows account name
3 Primary SID Primary 51D
Add Rule... Edit Rule... Bemove Rule...

10. Click Apply and then OK to save the claim rules for ADSelfService Plus.
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Step 3: Executing Windows PowerShell commands

Open Windows PowerShell on the AD FS server and execute the following commands:

e Setthe ADSelfService Plus claims provider to use sAMAccountName as the anchor claim type:

Set-AdfsClaimsProviderTrust -Targetldentifier <ADSSP IdP Entity URL> -AnchorClaimType
http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname

in/custom_saml_app/3888a71b21bBd6629 N

Note: The value of the <ADSSP IdP Entity URL> should be copied from the IdP metadata in

Step 11 of the Set up ADSelfService Plus to authenticate Outlook users section.

* Configure AD FS to redirect to ADSelfService Plus for authentication when logging into the Outlook

on Windows app:

Set-AdfsWebApiApplication -TargetName "<QOutlook> - Web API" -ClaimsProviderName
@("<Display name of ADSSP claims provider name in ADFS>")

EX Administrator: Windows PowerShell — O *®

PS C:\Users\Administrator> Set-AdfskWebApiApplication

Once configured, users will be presented with the ADSelfService Plus login prompt with MFA when

connecting to Exchange Server via Outlook on Windows.

Note:
¢ Replace <Display name of ADSSP claims provider name in ADFS> with the claim name copied

in Step 4 of the Adding a new claims provider trust section.
¢ Replace <Outlook> with the name for the native application group created in Step 6b of the

ADFS configuration for modern authentication section.
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Step 4: Enabling MFA for cloud apps in ADSelfService Plus
ADSelfService Plus provides 20 MFA methods to secure your applications. Follow the steps below to

configure the necessary authentication methods and enable MFA protection for Outlook.

Step 1: Create a policy for users requiring MFA

a. Log into ADSelfService Plus with admin credentials and navigate to Configuration > Self-Service >

Policy Configuration.

License Talk Back M o-

Ei ADSelfService Plus )

Dashboard Configuration Admin Support ¢ Domain Settings

Self-Service Policy Configuration @ Password Self-Service Modes ~

Policy Configuration T
Multi-factor Authentication
Password Expiration Notification +/| Reset Password
Enable users to securely reset passwords on their own (without supplying old passwords)
password Policy Enfarcer
/| unlock Account
Enable users to securely unlock accounts on their own.

Password Sync/Single Sign On

Conditional Access
Directory Self Service ~/| Self Update
Enable users to securely update Active Directory details on their own. Choose a Self Update Layout.
Administrative Tools >
/| Change Password
Security Center > Enable users to securely change passwords on their own (by supplying old passwords). B Select OUs/Groups & Advanced

Available Policies + Add New Policy

< « < 11ofl > »
Actions ‘Advanced Policy Name Permissions Domain Name Last Modified By Last Modified Time
s 5 0 C\" adselfservice.com Reset Password, Unlock Account, Self Update, Change Password ADSELFSERVICE

b. If only the specific subset of users needing MFA for Outlook are already in a policy, skip to Step e.

Otherwise, create a new policy by clicking the Add New Policy button.

License TalkBack A )~

5iE ADSelService Plus )

Dashboard Configuration ‘Admin Support $# Domain Settings
& Policy Configuration password Self-Service Modes ~

Policy Configuration

Multi-factor Authentication

Password Expiration Notification Reset Password

Enable users to securely reset passwords on their own (without supplying old passwords)
Password Policy Enforcer

Password Sync/Single Sign on Unlock Account
Enable users to securely unlock accounts on their own.

Conditional Access
Directory Self Service Self Update

Enable users to securely update Active Directory details on their own. Choose a Self Update Layout
Administrative Tools »

Change Password
Security Center > Enable users to securely change passwords on their own (by supplying old passwords). M Select OUs/Groups

pralble polces

xX « ¢ 11ofl > »
Actions ‘Advanced Policy Name Permissions Domain Name Last Modified By Last Modified Time
s 8 D _ adselfservice.com Reset Password, Unlock Account, Self Update, Change Password ADSELFSERVICE

c. Click Select OUs/Groups at the bottom right of the page, select the users who need MFA, and click OK.
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Select OUs/Groups
Select Domain ADSELFSERVICE

ol OUs 28 Groups
OUs for adselfservice.com Tree view  List view
=] adselfservice.com
Computers
Demo-Computers
Demo-Contact
Demo-Groups
Demo-Users

Domain Controllers

-
)
)
7
7
7
B

-

Users
awss12
Test
selfservice

technicians

R Ry 3 R

Don't inherit child OU(s)

Selected: 1 OUs 0 Groups Cancel
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d. Choose the password self-service features you want to enable for these users (Reset Password,

Unlock Account, Self Update, or Change Password), name the policy, and click Save Policy.

ADSelfService Plus )

Dashboard Reports Configuration Support

Self-Service Policy Configuration

Policy Configuration

Multi-factor Authentication

password Expiration Notification =P |./| Reset Password

Enable users to securely reset passwords on their own (without supplying old passwords)
Password Policy Enforcer
—— /| Unlock Account

Enable users to securely unlock accounts on their own.

password Sync/Single Sign On

Conditional Access
Directory Self Service == /| self update
Enable users to securely update Active Directory details on their own. Choose a Self Update Layout.
Administrative Tools »
——P ./ Change Password

Security Center > Enable users to securely change passwords on their own (by supplying old passwords).

Cancel

Available Policies
(o4
Actions Advanced Policy Name Permi

s 8 D <

ons

adselfservice.com Reset Password, Unlock Account, Self Update, Change Password

License  Talk Back a-

Search Employee

## Domain Settings

Password Self-Service Modes ~

B Select OUs/Groups it Advanced

+ Add New Policy

« < 110f1 > »

Modified By Last Modified Time

e. Go to Configuration > Self-Service > Multi-Factor Authentication > Authenticator Setup and select

the policy you just created from the drop-down menu.

ADSelfService Plus )

Dashboard Reports Configuration Admin

License Talk Back MY

# Domain Settings

Self-Service. Multi-factor Authentication &

Policy Configuration I Choose the Policy  adselfserviceplus.com v I

G R AT S Authenticators Setup  MFA for Reset/Unlock  MFA for Endpoints  MFA for Applications

Password Expiration Notification

Password Policy Enforcer Security Question & Answer (I

password Sync/Single Sign On EnzI LT
Conditional Access SMS Verification
Directory Self Service Google Authenticator
Administrative Tools » Microsoft Authenticator
Security Center > Azure AD MFA

Duo Security

RSA SecurlD

RADIUS Authentication

Push Notification Authentication

Fingerprint/Face ID Authentication

QR Code Based Authentication

TOTP Authentication (Using ADSelfService Plus Mobile App)
SAML Authentication

AD Security Questions

‘Yubikey Authenticator

Zoho OneAuth TOTP

Smart Card Authentication

Custom TOTP Authenticator

FIDO Passkeys (XM

[ Admin Guide %/ Need Features 7 Reportanssue  i'UserForums  (© Toll free : +1-844-245-1104 (@ Direct Phone : +1-408-916-9890

How to make users enroll? v

MFA Enrollment % Advanced
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f. Configure the desired authentication methods for the selected policy and click Save. You can learn

how to configure each authentication method by clicking the links on this page.

Step 2: Enable the required MFA factors

Since ADSelfService Plus will be prompted by AD FS to act as an IdP via a browser, you need to enable

MFA for Cloud Applications and select the required authenticators.

a. Log into ADSelfService Plus with admin credentials and navigate to Configuration > Self-Service >

Multi-Factor Authentication > MFA for Endpoints.

ADSelfService Plus )

Dashboard Reports Configuration

Self-Service Multi-factor Authentication &

Policy Configuration Choose the Policy | adselfserviceplus.com v

Multi-factor Authentication

Authenticators Setup  MFA for Reset/Unlock  MFA for Endpoints  MFA for Applications

Password Expiration Notification

Password Policy Enforcer MFA for Machine Login ()

Supported : Windows/macOs/Linux

Enable
password Sync/Single Sign On

Choose authenticators for Machine Login MFA
Conditional Access

Directory Self Service Choose authenticators for Offline MFA
Administrative Tools »

Security Center »

MFA for OWA Login ©
Supported : OWA/ECP of Exchange Server

Enable

Choose authenticators for OWA Login MFA

MFA for VPN Login ©
VPN providers that support RADIUS authentication

Enable

Choose authenticators for VPN login

MFA for Cloud Applications
Secure S50 login from ADSelfService Plus,

Enable ~  authentication factors.

Select the authenticators required

Save Settings. Cancel

| Admin Guide % Need Features 2 Report an Issue UserForums (@ Toll free : +1-844-245-1104

v factor authentication for Machine login. (3

License  TalkBack = A% @~

Q- search Employee

% Domain Settings

How to make users enroll? v

MFA Enrollment ¢ Advanced

v factor authentication for OWA Login.

~  factor authentication for VPN login.

(@ Machine-based MFA

(© Direct Phone : +1-408-916-2850

b. Under MFA for Cloud Applications, select the checkbox to Enable <number_of_factors> authentication

factors and choose the required authenticators from the drop-down menu. Click Save Settings.

ADSelfService Plus )

Configuration

Self-Service Multi-factor Authentication &

Policy Configuration Choose the Policy | adselfserviceplus.com v

Multi-factor Authy
uli;factor Authentication Authenticators Setup  MFA for Reset/Unlock  MFA for Endpoints  MFA for Applications

Password Expiration Notification

Password Policy Enforcer MFA for Machine Login

) Enable
ws/macOS/Linux

License Tolk Back A% @~

Q- Search Employes

2 Domain settings

How to make users enroll? +

MFA Enrollment % Advanced

v factor authentication for Machine login. (3

Password Sync/Single Sign On Supported : W
Choose authenticators for Machine Login MFA v
Conditional Access
Directory Self Service Choose authenticators for Offline MFA v e
Administrative Tools >
Security Center >
MFA for OWA Login Enable +  factor authentication for OWA Login.
Supported : OWA/ECP ange Server
Choose authenticators for OWA Login MFA v
MFA for VPN Login @ Enable ~  factor authentication for VPN login.
VPN providers that support RADIUS authentication
Choose authenticators for VPN login v
MFA for Cloud Applications /| Enable 1 |~ authentication factors.
Secure S0 login from ADSelfService Plus
Select the authenticators required | Google Authenticator, FIDO Passkeys v
Security Questions
:[/] Google Authenticator
‘Save Settings cancel
iv/] FIDO Passkeys
(@) Machine-based MFA ()
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c. By default, ADSelfService Plus requires users to enter a password before initiating MFA.
To enable Passwordless logins, click Advanced at the top-right corner, go to Endpoint MFA > Cloud

Applications Login MFA, select Enable Passwordless logins, and click Save.

Advanced (adssp.com @ Hep X

General  Reset/Unlock MFA  Endpoint MFA  Applications MFA QA Settings  Verification Code

VPN Login MFA

Cloud Applications Login MFA
+/| Cloud Apps Login MFA process idle time limitis | 5 mins.
Force enrollment for not enrolled users after successful password verification (3

/| Force enroliment post successful MFA for authenticators selected for other endpoints (2)

—

That's it! Users will now see the ADSelfService Plus login prompt with the configured MFA factors when

connecting to Exchange Server via the Outlook client.

For a visual walkthrough of the user experience, refer to this demo video.

Reference Documentation

e Microsoft Docs
e ManageEngine ADSelfService Plus Documentation
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Our Products

AD360 | Log360 | ADManager Plus | ADAudit Plus

RecoveryManager Plus | M365 Manager Plus

ManageEngine)

ADSelfService Plus

ADSelfService Plus is an identity security solution to ensure secure and seamless access
to enterprise resources and establish a Zero Trust environment. With capabilities such
as adaptive multi-factor authentication, single sign-on, self-service password
management, a password policy enhancer, remote work enablement and workforce
self-service, ADSelfService Plus provides your employees with secure, simple access to
the resources they need. ADSelfService Plus helps keep identity-based threats out,

fast-tracks application onboarding, improves password security, reduces help desk

tickets and empowers remote workforces. For more information about ADSelfService
Plus, visit

$ Get Quote ¥ Download
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